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Q1. What is a word processor? Write functions of a word processor.

Word processor a@ pakcnty.org%o

Word processing software is used to manipulate a text document, such as a

resume or areport. Youtypically enter text by typing, and the software provides

tools for copying, deleting and various types of formatting.
Functions of word processing
Some of the functions of word processing software include:

. Creating, editing, saving and printing documents.

a
b. Copying, pasting, moving and deletl\Q@\text within a document.

o

Formatting text, such as fontty@t_boboldlng underlining or italicizing.
d. Creating and editing tables$$

e. Inserting elements from O\?her software, such as illustrations or
photographs.

f. Correcting spellingand grammar

Q2. Discuss the Margins and Paper Size options in the Page Setup group.
Margins (HOTKEY: ALT+P+M)

A marginis the area or space between the main content of a page and the page
edges. This buttonis used to change the margins of the entire document or

selected section.
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Paper Size (HOTKEY: ALT+P+S+Z)

The size buttonis used to choose the size of the paper for current section or

cépakcity.org%o

Q3. Name and describe two options in Orientation.

entire document.

Orientation (HOTKEY: ALT+P+0)
Page orientation or print orientation is the placement of contents on a page.

Portrait mode

Portrait mode is the orientation of the page that prints the image vertically

across the page

Nk
Landscape mode Gvg\
=
{
Landscape mode is the orientation of trgﬁge that prints the image horizontally
across the page ®

Q4. How can we apply Margins in a document?

To set margins in Word, first click the “Layout” tab in the Ribbon. Then click the

“Margins” drop-down button in the “Page Setup” button group.

In this drop-down is a “Last Custom Setting” option, six preset margin choices,

and a “Custom Margins” command click on it and set your desire custom margin
then click ok or, to apply preset margins in Word, click one of the preset margin

choices shown inthe drop-down menu.

Q5. Describe the different types of breaks in MS Word.

Page Breaks in MS Word
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There are 4 types of section breaks you caninsertin a Microsoft Word

document.

Next page

Insert a section break and start the new section of the next page.

Continuous

Atype of breakin which a section is break and to start the new section on the

same page.

>
3
>
Even page $Q
\@
It inserts a section break and start the new section of the next even number
page.
Odd page

Inthis type a section breaks and start the new section on the next odd number

page.

Q6. Differentiate “Bring Forward” and “Send Backward” options inthe Arrange

group with example.

Bring Forward Send Backward
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Brings a selected objectinfrontofall | Sends a selected object behind all

other objects. other objects

HOTKEY useis ALT+P+A+F HOTKEY use is ALT+P+A+E
Q7. Explain the “Columns” option in the Page Setup group. ugpakcity.org 9-:
Columns

This buttonis used to split the text into two or more vertical columns. Short cut

key use forithe ALT+P+J

Q8. List and define Position and Wrap Text option in Arrange Group.

©
Position (HOTKEY: ALT+P+P+0) ‘\\\9
N
Position is used to place an object (picture @é’hape) onthe page whereveryou
@.
want.
\@*

Wrap Text (HOTKEY: ALT+P+T+W)

Text wrapping is used to arrange the text around an object like an image.

Q9. Inwhat way does aToC help book reader?

Table of Contents (ToC)

A Table of Contents (ToC) is an organized listing of the sections, groups and
headings of content in a document and identified by page numbers where they
are placed. It provides an overview of the

document and allows readers to go directly to specific section or contentin the
document. ToC usually appears after the Title Page in a document. MS Word 2010
provides an advanced feature for automatically creatinga ToC. A user can

create an Automatic or a Manual table of contents in a document.
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Q10. Write steps that will multiply 37 by 15 using the formula bar in MS Excel.

To multiply numbers, which are 37 and 15, placed in columns A2 and B2,

respectively. The objective is to add these two numbers using MS Excel formula.

To achieve this, follow these steps:

1. Select cell C2.

2. Type = (equal sign).

3.Selectcell A2 inthe worksheet by using the mouse or the keyboard. This
action places the cell reference A2 in the formula of selected cell.

4. Type ™. o\cb

9. Select cell B2inthe worksheet by usn'{g\the mouse or the keyboard to put that
cell'sreference inthe formula of sel ed cell.

6. Press Enter. \&S
7.The answer (555) will be calculated by MS Excel and displayed in the selected

cell (C2) where the addition formula was composed.

Q11. Why do we use Watermark in a document? Give some examples of

Watermarks.

Watermark (HOTKEY: ALT+P+P+W)

A watermark s a faded background image that displays behind the textin a
document. This button is used to insert logos, images or text behind the contents
of a page.

Common watermarks by default are

Confidential

Do not copy
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Q12. List uses of spreadsheets in business
1. Storing Data

One of the main uses of spreadsheets in business is storing data.

2. Manipulate and analyze data

Apart from storage, you can use spreadsheets to manipulate and analyze data.

For example, it contains a feature that allows you to enter custom formulas.

cépakcity.org %o
O

N\
O
3. Presentation/Visualization C\\\’
=
Jog
Spreadsheets are used often for visuali@@on purposes. They contain different

Q

tools and features that make it possib@.

4. Inform the Decision Making Process

Decisions that a business makes determines whether it will be successful or
not. Spreadsheets help managers and investors to make well-informed

decisions
9. Business Accounts and Budgeting

Coming up with abudget is not an easy task without the use of spreadsheets.
You can create atable and list the most important things followed by the least
important. There are features that will show you the sectors that need the most

attention. This information is very important, especially when purchasing items.
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Spreadsheets also assist accountants in managing business accounts. So funds

arereleased easily because some calculations are automated.

6. Invoices

Most spreadsheet platforms will allow you to integrate the invoice template. It

speeds up the process of receiving or dispatching products.

7.Wages

Managing wages is now easy thanks to the spreadsheets. Youcansetup a
O

formula that automatically calculates th%\lﬂ\lmber of hours an individual

DN
employee has worked. ,3&9

R
@.
\@*

13. What do you know about page layout tab?
Page layout tab

The Page Layout Tab allows userto controlthe look and feel of his or her
document. User can set margins, apply themes, control page orientation and
size, add sections and line breaks, display line numbers, and set paragraph
Indentation and lines. The Page Layout tab has have groups of related
commands namely Themes, Page Setup, Page Background, Paragraph and

Arrange.

Q14.what is Page setup group? Also discus if functions.

Page setup group
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1.

. Orientation (HOTKEY: ALT+P+0)

Page Setup settings help us set the page layout properties such as margins,
orientation and size. The settings in this section are often applied throughout the

document.

Margins (HOTKEY: ALT+P+M)
A marginisthe area or space between the main content of a page and the

page edges. This button is used to change the margins of the entire

document or selected section. s%pakcity.org%n

Page orientation or print orientation is the placement of contentson a
page. This button sets the contents of the page or section in portrait

(Vertical) or landscape (Horizontal) layouts ¢,

\
O
. Size (HOTKEY: ALT+P+S+Z2) 0\\\\
N
The size buttonis used to choose theggize of the paper for current section
or entire document. @$

. Columns (HOTKEY: ALT+P+J)

This button is used to split the text into two or more vertical columns.

. Breaks (HOTKEY: ALT+P+B)

Breaks button is used to insert page, section or column breaks in the

document.

. Line Numbers (HOTKEY: ALT+P+L+N)

This button is used to add line numbers on the left side of each line of the

document.

. Hyphenation (HOTKEY: ALT+P+H)

This button is used to specify how hyphenation in a document should be

applied.
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Q15. What do you know about page background group?
Page Background Group

These settings are used mostly for special documents such as certificates,

Invitations, brochures, essays, etc. It consists of 3 buttons namely, Watermark,

Page Color and Page Borders.

1. Watermark (HOTKEY: ALT+P+P+W)

A watermark s a faded background image that displays behind the text in

a document. This buttonis used to insert logos, images or text behind the

contents of a page.

2. Page Color (HOTKEY: ALT+P+P+C) \\

This buttonis used when user w§nts to apply a color for the background of

the page. \$@$
3. Page Border (HOTKEY: ALT+P+P+B)

Page Border button is used to put a border around the page.

Q16. What do you know about Paragraph Group? Discus its function.

Paragraph Group

The Paragraph Group is where we can modify all the settings of the paragraphs

that appearin our document. This allows us to set a few basic paragraph styles
and also adjust the indents and spacing's.

1. Indent Left (HOTKEY: ALT+P+I+L)

Indent Left is used to define amount of blank space (in centimeters) used
to separate a paragraph from left margin.

2. Indent Right (HOTKEY: ALT+P+|+R)
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Indent Right is used to define amount of blank space (in centimeters) used

to separate a paragraph fromright margin. 3 : E:
a%pakcny.org %o
3. Space Before (HOTKEY: ALT+P+S+B)

Space Beforeis used to indicate how much space (in points) is added

before the selected paragraph.
4. Space After (HOTKEY: ALT+P+S+A)
Space Afteris usedto indicate how much space (in points) is added after

the selected paragraph.

Q17. What do you know about Arrange group in MS-Word.

Arrange group O\Cb
The buttonsin Arrange Group help the use{g@&o quickly arrange graphical and

other elements of the document in rel h to the main textual content.

1. Position (HOTKEY: ALT+P+P+0)
Position is used to place an object (picture or shape) on the page
wherever you want.
2. Wrap Text (HOTKEY: ALT+P+T+W)
Text wrapping is used to arrange the text around an object like an image.
3. Bring Forward (HOTKEY: ALT+P+A+F)
Brings a selected object in front of all other objects.
4. Send Backward (HOTKEY: ALT+P+A+E)
Sends a selected object behind all other objects.
5. Selection Pane (HOTKEY: ALT+P+A+P)
Selection Pane is used to select, show, hide and change the order of

objects in the document.

6. Align (HOTKEY: ALT+P+A+A)
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Alignis used to place objects like pictures, shapes, icons, etc. in alignment

with margins, edge, or relative to another object in the document.

Q17. Write a short note on sorting

Sorting

Sorting is the process of rearranging or reordering data hased on different
criteria like size, quality, value and quantity. MS Excel has the ability to sort data

according to the needs of the user.

aépakcity.org 90
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Choosetherightanswer:

1. Which chart will be suitable to show the share of three partnersin a
business?

N
2. The software that is used for accounting purpose is:
a) MS Word b) MS E;gs%
c) MS Power point d) M%[:Q:cess

D

3. The software that is used to formatﬁdocument 1S:
a) MSWord b) MS Excel
c) MS Power point d) MS Access
4. The special character thatinitiates the formula mode in a cellis:
a)/ b) =
c) - d)*

9. The function which is used to re-arrange data according to specific criteriais
called:

a) Filtering b) Sorting

c) Organizing d) Grouping

6. |If we want to change the overall design of a word document, we should use:
a) themes b) page layout

c) watermark d) margins
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7. Thecorrectformulatocalculatethetotalinthegiventableis:

a)=B2+C2+D2+E2
c) =sum (B2to E2)

=B2+E2
=sum(B2fromE?2)

b)
d)

8. Thecorrectformulatocalculatethepercentageinthegiventableis:

Poglivh | Sindb/urdu | Maths |

Sceace |

|
|
l

Tk _» e ¥ B -
3% ! 14 | 34 !

a)=B2+C2+D2+E2/400*100
b)=B2+C2+D2+E2*100
c)=(B2+C2+D2+E2)/400*100
d)=(B2+C2+D2+E2) /100 *400\@*

9. Charts are basically used to
a) design tables b) organize datain tables

c) Sort datain different columns  d) show the quantities and their

relationships graphically

10. To apply the table of contents automatically, the most important task is to

properly define the
a) levels of heading b) page numbering

d) themes

oé pakcity.orggo

Please visit for more data at: www.pakcity.org

c) page layout






